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Paper Set 1 · 04 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A shopkeeper marks his goods 25% above the cost price and allows
a discount of 10% on the marked price. What is his percentage profit
or loss?

A.  12.5 % profit

B.  12.5 % loss

C.  12.7 % profit

D.  10.5 % profit

✓

Q2 Quant
Pooja and Meena can complete a task in 10 days, while Raj and Anil
can complete the same task in 15 days. How long will Pooja, Meena,
Raj, and Anil take to complete it together?

A.  6 days

B.  5 days

C.  8 days

D.  4 days

✓

Q3 Quant
A and B start a business. A invests ₹1,20,000 and B invests
₹1,60,000. After a few months, C joins with ₹1,80,000. At the end of
the year, the profit is divided in the ratio 3 : 4 : 3. After how many
months did C join?

A.  4

B.  6

C.  3

D.  5

✓

Q4 Quant
The highest common factor (HCF) of the two numbers 72 and 126 is:

A.  9

B.  12

C.  16

D.  18

✓

Q5 Quant
The telegraph poles on a roadside are 50 metres apart. How many
of them will be passed by a car in 4 hours if the speed of the car is
45 km/hr, if the counting begins just before the first pole is passed?

A.  3601

B.  3600

C.  3602

D.  3605

✓

Q6 Quant
Steve covers a certain distance at a speed of 40 km/hr. If he
increases the speed to 48 km/hr, he takes 45 minutes less to cover
that distance. Find the distance (in km) that Steve travels.

A.  150

B.  168

C.  174

D.  180

✓

Q7 Quant
Four friends P, Q, R, and S start a business together. P invests
₹15,000 for 12 months, Q invests ₹20,000 for 9 months, R invests
₹25,000 for 8 months, and S invests ₹30,000 for 6 months. If the
total profit is ₹56,000, what is Q's share (Rounded off to the nearest
integer).

A.  ₹13,682

B.  ₹13,652

C.  ₹13,622

D.  ₹13,602

✓

Q8 Quant
If the fourth proportional to 28, X and 42 is 105, then find the value
of X.

A.  42

B.  56

C.  70

D.  84
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✓

Q9 Quant
In a moderately skewed distribution, if the mode is 12 less than the
median and the mean is 42, find the median.

A.  32

B.  36

C.  37

D.  39

✓

Q10 Quant
If 20% of a number is added to 42, then the result is the same
number. 70% of the same number is:323

A.  36.75

B.  46.75

C.  66.75

D.  56.75

✓

Q11 Quant
A, B and C can together finish a piece of work in 2 days. If A alone
can finish the same work in 16 days and B can also do it alone in 16
days, how many days will C take to finish thrice the same work
alone?

A.  8

B.  16

C.  24

D.  9

✓

Q12 Quant
In a division sum, the divisor is 8 times the quotient and 5 times the
remainder. If the remainder is 48, what is the dividend?2907

A.  7248

B.  7253

C.  7243

D.  7252

✓

Q13 Quant
What sum of money (in ₹) will amount to ₹4920 at 4% per annum
simple interest in 5 years?6927

A.  4100

B.  4050

C.  4150

D.  24600

✓

Q14 Quant
If the compound interest on a sum of ₹y at 4% per year for 2 years,
compounded annually, is ₹255, what will be the amount after 2
years?

A.  ₹3380

B.  ₹3170

C.  ₹2961

D.  ₹3727

✓

Q15 Quant
The bisectors of ∠B and ∠C of an isosceles ∆ABC with AB = AC,
intersect each other at O. If ∠BOC = 110°, find the measure of
external angle ∠ABD, where D lies on the extended part of side CB.

A.  70°

B.  80°

C.  110°

D.  100°

✓

Q16 Quant
The larger of two supplementary angles is 46° more than the
smaller. The smaller angle (in degrees) is:

A.  67

B.  61

C.  60

D.  63

✓

Q17 Quant
A number when increased by 60%, gives 3920. The number is:

A.  2450

B.  2900

C.  1225

D.  1350

✓

Q18 Quant
Rina sells a toy to Reshmi at a profit of 20%. Reshmi sells the same
toy to Chandra for ₹2160 and makes a profit of 20%. What is the cost
price at which Rina purchased the toy?

A.  ₹1300

B.  ₹1400

C.  ₹1500

D.  ₹1600
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✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant

1552

A.  75°

B.  90°

C.  110°

D.  125°

GA

✓

Q21 GA
In May 2025, Prime Minister Narendra Modi inaugurated the
Vizhinjam International Seaport in which of the following states?

A.  Andhra Pradesh

B.  Karnataka

C.  Kerala

D.  Tamil Nadu

✓

Q22 GA
Which of the following states have started India’s first Vistadome
train jungle safari in May 2025?

A.  Uttar Pradesh

B.  Jharkhand

C.  Madhya Pradesh

D.  Karnataka

✓

Q23 GA
The atomic mass of oxygen is approximately:

A.  15.999 u

B.  8 u

C.  16.999 u

D.  12.000 u

✓

Q24 GA
The Hathigumpha inscription, engraved at Udayagiri near
Bhubaneswar, records the deeds of which ruler?

A.  Ashoka

B.  Kharavela

C.  Samudragupta

D.  Anantavarman Chodaganga
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✓

Q25 GA
When a cell is about to divide, what happens to the chromatin
material?

A.  Disappears from the cell

B.  Gets organised into chromosomes

C.  Changes into RNA

D.  Moves out of the nucleus

✓

Q26 GA
In Aug 2025, CCEA cleared a 6-lane access-controlled Capital Region
Ring Road (Bhubaneswar Bypass). What is the approved length?

A.  98.400 km

B.  110.875 km

C.  125.000 km

D.  150.250 km

✓

Q27 GA
Dormant volcanoes are commonly referred to as ________.

A.  Sleeping volcanoes

B.  Composite volcanoes

C.  Erupting volcanoes

D.  Dead volcanoes

✓

Q28 GA
Which Indian location has been recognized by UNESCO as a World
Heritage Site for its mangrove ecosystem?

A.  Nagarhole

B.  Gir

C.  Sundarbans

D.  Periyar

✓

Q29 GA
During the state-level Nuakhai Bhetghat at Sambalpur in September
2025, the Odisha CM announced development of an industrial
corridor running from _____ to ____ via Sambalpur.

A.  Paradip; Rourkela

B.  Bhubaneswar; Cuttack

C.  Puri; Bhubaneswar

D.  Jeypore; Koraput

✓

Q30 GA
Coastal plain of Odisha is also known as __________.

A.  Gift of Five Rivers

B.  Gift of Six Rivers

C.  Gift of Seven Rivers

D.  Gift of Eight Rivers

✓

Q31 GA
Who among the following assumed charge as the Director General
of the National Cadet Corps (NCC) in 2025?

A.  Lt Gen Gurbirpal Singh

B.  Lt Gen Rajesh Sharma

C.  Lt Gen Virendra Vats

D.  Lt Gen Manoj Pande

✓

Q32 GA
Dadabhai Naoroji’s “Drain Theory” was important in the Indian
National Movement because it _______.

A.  Justified British economic policies as beneficial to India’s
development.

B.  Explained how wealth generated in India was transferred to
Britain without adequate return.

C.  Focused only on agricultural taxation as the main cause of
poverty in India.

D.  Argued that industrialisation in India was faster under British
rule.

✓

Q33 GA
How does the magnetic field magnitude change if the current is
increased in a straight current-carrying conductor?

A.  Decreases

B.  Increases

C.  No change

D.  Reverses

✓

Q34 GA
In February 2026, India hosted the "AI Impact Summit" in New Delhi.
The summit’s declaration focused on seven pillars known as the:

A.  Seven Chakras

B.  Seven Wisdoms

C.  Seven Digital Codes

D.  Seven Shields
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✓

Q35 GA
Which of the following statements about Amir Khusrau is correct?

A.  He was born in Gwalior and served as a prominent musician
in the court of Emperor Akbar.

B.  He is considered the primary composer of the Dhrupad form
of music.

C.  He is credited with the invention of the Sitar and the musical
melodies of Qawwali and Tarana.

D.  He was a disciple of Miyan Tansen and learned the art of
Arabic and Persian music from him.

✓

Q36 GA
Which countries lie to the north-west of India?

A.  China and Nepal

B.  Afghanistan and Pakistan

C.  Bhutan and Bangladesh

D.  Myanmar and Sri Lanka

✓

Q37 GA
Which indicator represents the average number of children a
woman is expected to have during her reproductive years?

A.  Literacy rate

B.  Life expectancy

C.  Total fertility rate

D.  Sex ratio

✓

Q38 GA
According to the Natya Shastra by Bharat Muni, which group of
Indian musical instruments is defined by the use of strings to
produce sound?

A.  Ghan Vadya

B.  Sushir Vadya

C.  Avanaddha Vadya

D.  Tat Vadya

✓

Q39 GA
Which of the following is a key reason for India’s regional economic
disparity?

A.  Equal industrial development across all states

B.  Uniform access to education and infrastructure

C.  Uneven distribution of resources and investment

D.  High population growth in all regions equally

✓

Q40 GA
Which Article of the Indian Constitution provides the directive to the
state to make laws to prevent malnutrition and improve public
health?

A.  Article 45

B.  Article 46

C.  Article 47

D.  Article 48
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English

✓

Q41 English
Select the most appropriate option to fill in the blank.

Although the council _____ a vote, the outcome remained unofficial due to procedural delays.

A.  was conducted

B.  conducting

C.  had conducted

D.  conduct

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

A place where dead bodies are kept before burial

A.  Graveyard

B.  Mausoleum

C.  Morgue

D.  Cemetery

✓

Q43 English

Read the given passage carefully and answer the following questions.

Reality television is a type of show that claims to present unscripted dramatic or funny situations, real events, and ordinary people instead of
professional actors. Although such shows have been around for many years, they have become much more popular in recent times. One reason
people enjoy them is that they put regular individuals in unusual, challenging, or surprising situations, which attracts viewers’ attention. These
programs can also make participants widely known, sometimes turning them into celebrities or public figures. However, some experts say that
the term “reality television” is not entirely accurate because many shows are partially scripted and manipulated by producers. In competition-
based or special-living-environment shows, producers often dictate the format, guide daily activities, and curate the environment, creating a
partly artificial world for entertainment. Despite this, viewers still enjoy the mix of drama, excitement, tension, and human reactions these shows
consistently offer.

Identify the correct tone of the passage from the options.

A.  Highly critical and accusatory

B.  Enthusiastic and promotional

C.  Informative and balanced

D.  Sarcastic and dismissive

✓

Q44 English
Choose the option that suggests the main theme of the passage.

A.  How reality shows entertain viewers

B.  The role of celebrities in television

C.  How reality television works and its impact

D.  Differences between scripted and live shows
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✓

Q45 English
Which statement is a fact according to the passage?

A.  Reality television has become more popular in recent times.

B.  Reality shows always reflect real life perfectly.

C.  Every participant becomes a public figure.

D.  The audience prefers scripted shows.

✓

Q46 English
Which of the following can be inferred from the passage?

A.  Reality shows are completely natural and unscripted.

B.  Producers often manipulate situations to increase drama.

C.  All participants become national celebrities.

D.  Reality television is declining in popularity.

✓

Q47 English
It can be inferred from the passage that the appeal of reality shows comes from:

A.  offering only prizes to participants

B.  having complete lack of producer control

C.  the long duration of each episode

D.  showing ordinary people in unusual situations

✓

Q48 English
Identify the sentence that is not correctly written in indirect speech.

A.  Meera said that she had seen a koala in the park.

B.  Kiran asked if they were ready for the journey.

C.  They mentioned that the waves were calm.

D.  Priya said that I am love kangaroos.

✓

Q49 English
Select the most appropriate antonym of the underlined word in the given sentence.
The sky was opaque with thick clouds, blocking all sunlight.

A.  Dark

B.  Murky

C.  Transparent

D.  Cloudy
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Q50 English
Select the most appropriate proverb to substitute the highlighted segment in the given sentence.

He felt disappointed when the product looked impressive online but was poor in quality, proving that appearances can be misleading.

A.  when in Rome, do as the Romans do

B.  actions speak louder than words

C.  all that glitters is not gold

D.  beggars can’t be choosers

✓

Q51 English
Choose the option which has correct spelling of the underlined word in the given sentence.

She couldn’t hide her embarassment after tripping on the stage.

A.  She couldn’t hide her embarrassment after tripping on the stage.

B.  She couldn’t hide her embarasment after tripping on the stage.

C.  She couldn’t hide her after tripping on embarasement the stage.

D.  She couldn’t hide her embarrasmant after tripping on the stage.

✓

Q52 English
Choose the correct option that converts the following sentence from Active voice to Passive voice.
"Someone has watered the plants in the greenhouse."

A.  The plants in the greenhouse have been watered by someone.

B.  The plants in the greenhouse has been watered by someone.

C.  Someone has been watered the plants in the greenhouse.

D.  The plants in the greenhouse had been watered by someone.

✓

Q53 English
Identify the antonym of the underlined word in the given sentence.

After the storm, the streets were chaotic.

A.  orderly

B.  disorganized

C.  turbulent

D.  messy

✓

Q54 English
A statement has been given with highlighted text. You are required to replace the text with the correct idiom given in the options.

Vishnu won the big ticket and bought a new house—everyone in town called him a very lucky person.

A.  the life of Riley

B.  a rare bird

C.  a lucky stiff

D.  a lame duck
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✓

Q55 English
Given below is a set of labeled segments of a sentence. Out of the given options, select the most logical order to form a coherent sentence.

P: their skills in order to remain relevant
Q: individuals must continuously adapt and upgrade
R: in an era dominated by rapid technological advancements,
S: and competitive in an increasingly dynamic job market

A.  RQPS

B.  SQRP

C.  RPSQ

D.  QSRP

✓

Q56 English
Complete the sentence by choosing the correct option.

The ruins of the temple provided a ............... glimpse into the country's ancient history.

A.  global

B.  kind

C.  fascinating

D.  loyal

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

He adopted ___ dog from the shelter last week.

A.  a

B.  an

C.  the

D.  no article required

✓

Q58 English
Select the option that can be used as a one-word substitute for the highlighted group of words.

The professor’s lecture was complex, but the essential or most important part of something—the core meaning—was about the value of
ethical leadership.

A.  Fragment

B.  Ornament

C.  Margin

D.  Pith
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✓

Q59 English
Select the most appropriate option to fill in the blank.

_______ students who met the deadline were appreciated by the principal in the morning assembly.

A.  Few

B.  A few

C.  The few

D.  A little

✓

Q60 English
The question below consists of a set of labeled phrases. Out of the four options given, select the most logical order to form a coherent
sentence.
P: the villagers welcomed the officer
Q: who had resolved their water crisis
R: when he arrived in the morning
S: with garlands and applause

A.  PQRS

B.  RQPS

C.  RSPQ

D.  PRQS

Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଜାପାନ ଦ୍ଵି ତୀୟ ବି ଶ୍ୱଯୁ ଦ୍ଧ ପରେ ଜି ତି ଥି ବା ଦେଶଗୁ ଡି କ ସହ ____ ସନ୍ଧି  କରି ଥି ଲା ।''

A.  ଶାନ୍ତି ରେ

B.  ଖୁ ସି ରେ

C.  ଦୁଃ ଖରେ

D.  ଈର୍ଷା ରେ

✓

Q62 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''କର୍ମ ଚାରୀ ଜଣକ ____ କାର୍ଯ୍ୟ ଟି କୁ  ସମ୍ପନ୍ନ କରି ଥି ଲେ ।''

A.  ଦୟାରେ

B.  ଧୈ ର୍ଯ୍ୟ ରେ

C.  ଶାନ୍ତି ରେ

D.  ଈର୍ଷା ରେ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ପାହାଡ଼ଟି  ଖୁ ବ "ଉଚ୍ଚ" ଅଟେ।

A.  ନି ମ୍ନ

B.  ଛୋଟ

C.  ନୂ ତନ

D.  ଦୀର୍ଘ

✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ଆମେ ଏକ ନୂ ଆ "ଘର" ତି ଆରି  କରି ଛୁ ।

A.  ନି ବାସ

B.  ଜଙ୍ଗଲ

C.  ସ୍କୁଲ

D.  ଦୋକାନ

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Chilika Lake is Asia’s largest brackish water lagoon.

A.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ବୃ ହତ୍ତମ ଲୁ ଣାଜଳ ହ୍ର ଦ ଅଟେ।

B.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ସବୁ ଠାରୁ  ବଡ଼ ଖାରାପାଣି  ହ୍ର ଦ ଅଛି ।

C.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ବଡ଼ ଖାରାପାଣି  ହ୍ର ଦ ଅଛନ୍ତି ।

D.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆ ସବୁ ଠାରୁ  ବଡ଼ ଖାରାପାଣି  ହେଉଛି ।

✓

Q66 Odia
ସଠି କ ତତ୍ସମ ଶବ୍ଦ ବାଛନ୍ତୁ: “ମନ” ର ତତ୍ସମ କଣ?

A.  ମନଶ୍ଚି

B.  ମନସ୍

C.  ମନସା

D.  ମନସ୍ତି

✓

Q67 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୁଁ  ଏବେ ବଜାର ଯାଉଛି  ।

A.  I am going to the market now.

B.  I was going to the market .

C.  I had gone to the market now.

D.  I have been going to the market.
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✓

Q68 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମେ ମତେ କି ଛି  ନକହି  କୁ ଆଡେ ଏକୁ ଟି ଆ ଚାଲି ଯାଇଥି ଲ ?

A.  Where have you gone alone without telling me?

B.  Where did you go alone without telling me?

C.  Why did you go alone without telling me?

D.  How did you go alone without telling me?

✓

Q69 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ|

ଭାରତରେ ଭୋଟର ତାଲି କାର ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ (SIR ) ହେଉଛି  ଭାରତୀୟ ନି ର୍ବା ଚନ କମି ଶନ (ECI) ଦ୍ୱାରା ଗ୍ର ହଣ କରାଯାଇଥି ବା ଏକ କେନ୍ଦ୍ରି ତ ଏବଂ ତ୍ୱରାନ୍ୱି  ତ କାର୍ଯ୍ୟ  ଯାହା
ଭୋଟର ତାଲି କା ସଠି କ, ଅନ୍ତର୍ଭୁ କ୍ତ ଏବଂ ଅପଡେଟ ରହି ବାର ନି ଶ୍ଚି ତ କରି ଥାଏ। ପ୍ର ତି ବର୍ଷ  ଭୋଟର ତାଲି କା ସଂଶୋଧନ କରାଯାଉଥି ବା ବେଳେ, ଏକ ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ ଏପରି
ପରି ସ୍ଥି ତି ରେ କରାଯାଏ ଯେଉଁ ଠାରେ ଭୋଟରଙ୍କ କ୍ଷେତ୍ର ରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ପରି ବର୍ତ୍ତ ନ ଆଶା କରାଯାଏ, ଯେପରି କି  ବଡ଼ ପରି ମାଣର ସ୍ଥାନାନ୍ତର, ପ୍ରା କୃ ତି କ ବି ପର୍ଯ୍ୟ ୟ, ସହରାଞ୍ଚଳ ପ୍ର ସାରଣ, କି ମ୍ବା
ବି ଦ୍ୟମାନ ତାଲି କାରେ ଯଥେଷ୍ଟ ତ୍ରୁ ଟି  ଚି ହ୍ନଟ। ଏହାର ଉଦ୍ଦେଶ୍ୟ ହେଉଛି  ସମସ୍ତ ଯୋଗ୍ୟ ଭୋଟରଙ୍କୁ  ଅନ୍ତର୍ଭୁ କ୍ତ କରି ବା, ଅଯୋଗ୍ୟ କି ମ୍ବା ଡୁ ପ୍ଲି  କେଟ୍  ପ୍ର ବେଶଗୁ ଡ଼ି କୁ  ଦୂ ର କରି ବା ଏବଂ ନାମ, ଠି କଣା,
ବୟସ କି ମ୍ବା ଅନ୍ୟାନ୍ୟ ଜନସଂଖ୍ୟାଗତ ବି ବରଣୀ ସହି ତ ଜଡି ତ ତ୍ରୁ ଟି  ସଂଶୋଧନ କରି ବା। ଏହି  କାର୍ଯ୍ୟ  ସମୟରେ, ବୁ ଥ୍ -ସ୍ତରୀୟ ଅଧି କାରୀ (BLO) ଏବଂ କ୍ଷେତ୍ର  କର୍ମ ଚାରୀମାନେ ଯୋଗ୍ୟ ଭୋଟରଙ୍କୁ
ଯାଞ୍ଚ କରି ବା ପାଇଁ  ପରି ବାର ପରି ଦର୍ଶ ନ କରନ୍ତି , ନୂ ତନ ଭୋଟରଙ୍କ ପାଇଁ  ଫର୍ମ -6 ଆବେଦନ ସଂଗ୍ର ହ କରନ୍ତି  (ବି ଶେଷକରି  ଯେଉଁ ମାନେ 18 ବର୍ଷ  ବୟସରେ ପହଞ୍ଚି ଛନ୍ତି ), ଏବଂ ଯଥାକ୍ର ମେ ଫର୍ମ -7,
ଫର୍ମ -8 ଏବଂ ଫର୍ମ -8A ପ୍ର କ୍ରି  ୟାକରଣ କରନ୍ତି  ଯାହା ଦ୍ଵାରା ବି ଲୋପ, ସଂଶୋଧନ ଏବଂ ସ୍ଥାନାନ୍ତରଣ ହୁ ଏ।
ଏହି  ପ୍ର କ୍ରି  ୟାରେ ଜନ ଅଂଶଗ୍ର ହଣ ଏବଂ ସ୍ୱଚ୍ଛତା ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରେ। ଭୋଟଗ୍ର ହଣ କେନ୍ଦ୍ର ଗୁ ଡ଼ି କରେ ଡ୍ରା ଫ୍ଟ  ତାଲି କା ପ୍ର କାଶି ତ ଏବଂ ପ୍ର ଦର୍ଶିତ ହୁ ଏ, ଯାହା ନାଗରି କମାନଙ୍କୁ
ସେମାନଙ୍କର ବି ବରଣୀ ଯାଞ୍ଚ କରି ବାକୁ  ଏବଂ ଯଦି  କି ଛି  ତ୍ରୁ ଟି  ଥାଏ ଆପତ୍ତି  ଉଠାଇବାକୁ  ସକ୍ଷମ କରି ଥାଏ, । ଭୋଟର ହେଲ୍ପଲାଇନ୍  ଆପ୍  ଏବଂ NVSP ପୋର୍ଟା ଲ୍  ମାଧ୍ୟମରେ ସ୍ୱତନ୍ତ୍ର ଶି ବି ର, ଭୋଟର
ସଚେତନତା ଅଭି ଯାନ, ସହାୟତା ଡେସ୍କ ଏବଂ ଅନଲାଇନ୍  ସେବା ନାଗରି କମାନଙ୍କୁ  ସୂ ଚନା ପଞ୍ଜି କରଣ ଏବଂ ଯାଞ୍ଚ କରି ବାରେ ସହାୟତା କରେ। ECI ବରି ଷ୍ଠ ନାଗରି କ, ଭି ନ୍ନକ୍ଷମ ବ୍ୟକ୍ତି , ସୀମାନ୍ତ
ସମ୍ପ୍ରଦାୟ ଏବଂ ସେବା ଭୋଟର ଭଳି  ଦୁ ର୍ବ ଳ ଗୋଷ୍ଠୀମାନଙ୍କ ପ୍ର ତି  ମଧ୍ୟ ବି ଶେଷ ଧ୍ୟାନ ଦି ଏ ଯାହା ଦ୍ୱାରା ସେମାନଙ୍କର ଅନ୍ତର୍ଭୁ କ୍ତି  ସୁ ନି ଶ୍ଚି ତ ହୋଇପାରି ବ। ତ୍ରୁ ଟି , ପ୍ର ତି ରୂ ପଣ କି ମ୍ବା ନକଲି  ଭୋଟିଂ
ପ୍ର ବେଶକୁ  ରୋକି ବା ପାଇଁ  କଠୋର ପ୍ର କ୍ରି  ୟା ଅନୁ ସରଣ କରାଯାଏ। ଦାବି  ଏବଂ ଆପତ୍ତି ର ସମାଧାନ ହେବା ପରେ, ଏକ ଚୂ ଡ଼ାନ୍ତ ଅପଡେଟ ଭୋଟର ତାଲି କା ପ୍ର କାଶି ତ ହୁ ଏ। ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ
ରି ଭି ଜନ ନି ର୍ବା ଚନ ପ୍ର କ୍ରି  ୟାର ଅଖଣ୍ଡତାକୁ  ସୁ ଦୃ ଢ଼ ​​କରି ବା ଏବଂ ଏକ ସ୍ୱଚ୍ଛ ଏବଂ ସଠି କ ଭୋଟର ତାଲି କା ଆଧାରରେ ନି ର୍ବା ଚନ ପରି ଚାଳନା ନି ଶ୍ଚି ତ କରି ବା ପାଇଁ  ଏକ ସୁ ରକ୍ଷା ଭାବରେ କାର୍ଯ୍ୟ  କରେ।

ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ ମୁ ଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ କଣ?

A.  ନି ର୍ବା ଚନକୁ  ଶୀଘ୍ର  ପରି ଚାଳନା କରି ବା

B.  ଭୋଟର ତାଲି କାକୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  ସଂଶୋଧନ ଏବଂ ଅପଡେଟ୍  କରି ବା

C.  ଭୋଟ ଗଣନାକାରୀଙ୍କୁ  ହାତରେ ଗଣନା କରି ବା

D.  ପୋଲିଂ  ଅଧି କାରୀମାନଙ୍କୁ  ତାଲି ମ ଦେବା

✓

Q70 Odia
ଫର୍ମ -6 କଣ ପାଇଁ  ବ୍ୟବହାର କରାଯାଏ?

A.  ନାମ ବି ଲୋପ କରି ବା

B.  ନୂ ତନ ଭୋଟର ଯୋଡି ବା

C.  ପ୍ର ବେଶ ସଂଶୋଧନ

D.  ଅନ୍ୟ ନି ର୍ବା ଚନମଣ୍ଡଳୀକୁ  ଭୋଟ ସ୍ଥାନାନ୍ତର କରି ବା

✓

Q71 Odia
କ୍ଷେତ୍ର  ଯାଞ୍ଚରେ କେଉଁ  ଅଧି କାରୀମାନେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରନ୍ତି ?

A.  ପୋଲି ସ ଅଧି କାରୀ

B.  ବୁ ଥ୍ -ସ୍ତରୀୟ ଅଧି କାରୀ

C.  ବି ଚାରପତି

D.  ଜନଗଣନା ଅଧି କାରୀ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q72 Odia
ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ କେତେବେଳେ କରାଯାଏ?
ଯେତେବେଳେ ______.

A.  ପ୍ର ବଳ ବର୍ଷା  ହୁ ଏ

B.  ଭୋଟର ଜନସଂଖ୍ୟାରେ ଯଥେଷ୍ଟ ପରି ବର୍ତ୍ତ ନ ହୁ ଏ

C.  ନି ର୍ବା ଚନ ବାତି ଲ ହୁ ଏ

D.  ବଜେଟ୍  ଘୋଷଣା ହୁ ଏ

✓

Q73 Odia
ନି ମ୍ନ  ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ର ନି ଷ୍ପତ୍ତି  ନେଲା ପରେ ଭୋଟର ତାଲି କା ଚୂ ଡ଼ାନ୍ତ ହୁ ଏ?

A.  ଦାବି  ଏବଂ ଆପତ୍ତି

B.  ନାମାଙ୍କନ ପତ୍ର

C.  ଭୋଟପତ୍ର

D.  ବଜେଟ୍  ପ୍ର ସ୍ତାବ

✓

Q74 Odia
ଯେଉଁ  ବି ଶେଷଣ ପଦ ଅବ୍ୟୟ ପଦକୁ  ବି ଶେଷଣ କରେ,ତାକୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ସର୍ବ ନାମର ବି ଶେଷଣ

C.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  ଅବ୍ୟୟର ବି ଶେଷଣ

✓

Q75 Odia
ନି ମ୍ନୋ କ୍ତ ଶବ୍ଦଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  'ଇଷ୍ଟ' ଶବ୍ଦର ବି ପରୀତାର୍ଥ ବୋଧକ ଶବ୍ଦଟି  ନି ରୂ ପଣ କର।

A.  କଷ୍ଟ

B.  ଇହ

C.  ଅନି ଷ୍ଟ

D.  ଅସୁ ସ୍ଥ
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Computer

✓

Q76 Computer
What does CD stand for?

A.  Compact Disc

B.  Common DIsc

C.  Capture Disc

D.  Current Disc

✓

Q77 Computer
When a student receives an email with an attached file, what is the
most important security measure they should take before opening
it?

A.  Reply to the sender immediately confirming receipt

B.  Change the file extension

C.  Forward the email to all their contacts first

D.  Scan the file with an antivirus program or check the sender's
identity

✓

Q78 Computer
An editor wants to quickly remove all bold formatting, font color
changes, and customized font sizing from a large, highlighted
section of text, returning it only to the plain formatting of the
default document style. Which specific keyboard shortcut is the
most efficient way to achieve this rapid restoration of the default
text appearance?

A.  Ctrl + A

B.  Ctrl + B

C.  Ctrl + E

D.  Ctrl + spacebar

✓

Q79 Computer
Which of the following is NOT a valid Internet access technique?

A.  Dial-up connection

B.  Broadband connection

C.  Bluetooth tethering

D.  DVD-ROM access

✓

Q80 Computer
Which Windows element gives access to system settings and
installed apps?

A.  Start Menu

B.  Taskbar

C.  Quick Launch

D.  Status Bar

✓

Q81 Computer
Which page formatting option would you use to change a document
from portrait to landscape orientation in MS Word?

A.  Font Size

B.  Page Margins

C.  Page Orientation

D.  Line Spacing

✓

Q82 Computer
What is the main difference between application software and
system software?

A.  Application software controls hardware,
system software is for users

B.  Application software and system
software are same

C.  Application software is for users, system
software controls system

D.  Both are only for gaming

✓

Q83 Computer
Which of the following is a common application of computers in
education?

A.  Manufacturing computer hardware

B.  Repairing computer components

C.  Creating interactive learning software

D.  Designing computer circuits

✓

Q84 Computer
What is the shortcut key for a bulleted list in Google Docs?

A.  Ctrl + Shift + r

B.  Ctrl + Shift + j

C.  Ctrl + Shift + 7

D.  Ctrl + Shift + 8

✓

Q85 Computer
In 'ADDRESS(1,2),' the function '1' refers to the ________ value.

A.  absolute_relative_mode

B.  use_a1_notation

C.  row

D.  column
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✓

Q86 Computer
During a professional presentation using a dual-monitor setup,
which Microsoft PowerPoint feature allows the presenter to access
detailed notes, upcoming slides, and a timer, while the audience
views only the current slide on the projector?

A.  Slide Show View

B.  Presenter View

C.  Notes Page View

D.  Outline View

✓

Q87 Computer
What is the primary purpose of Kiosk Mode in MS PowerPoint's Slide
Show Setup?

A.  To allow slides to advance automatically without user
interaction

B.  To prevent the presenter from editing slides

C.  To force the presentation to close after a specific time

D.  To enable animations and transitions automatically

✓

Q88 Computer
Which of the following actions starts Edit mode and places the
cursor at the end of the cell content?

A.  Double-clicking the cell

B.  Clicking the cell and then clicking the formula bar

C.  Pressing F2 after selecting the cell

D.  Pressing Enter

✓

Q89 Computer
Tanya wants to enhance her presentation with decorative images
that match her topic. Which option should she select to insert such
visual elements quickly without drawing them herself?

A.  Use the 'Transitions' tab to change slide effects.

B.  Use the 'Design' tab to apply a theme.

C.  Use the ‘Insert’ tab and select ‘Online Pictures’ or ‘Clip Art’.

D.  Use the 'Animations' tab to insert media.

✓

Q90 Computer
Which of the following steps correctly allows a user to change the
default column width for all columns in an MS Excel 2021
worksheet?

A.  Go to Page Layout → Width → Set as Default

B.  Select entire worksheet → Home tab → Format → AutoFit
Column Width

C.  Home tab → Format → Default Width → Enter value → click on
OK

D.  Right-click on the worksheet → Column Width → Enter value →
Set as Global
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✓

Q91 Reasoning
A is the son of B. B is the mother of C. C is the brother of D. D is the
daughter of E. How is A related to E?1979

A.  Daughter

B.  Son

C.  Brother

D.  Father

✓

Q92 Reasoning
Seven students, A, B, C, D, E, F and G, are sitting in the front row of a
class, facing towards north. C is sitting at the extreme left end of the
row. Only F is sitting between B and D. A is sitting fourth to the right
of F. A and E are both immediate neighbours of G. D and E are not
immediate neighbours. Who is sitting second to the right of F?2141

A.  B

B.  G

C.  D

D.  E

✓

Q93 Reasoning
Seven boxes A, T, K, D, E, F and R are kept one over the other but not
necessarily in the same order. Only two boxes are kept below T. Only
four boxes are boxes are kept below E. Only one box is kept between
D and E. F is kept immediately below K. R is not kept above A. Which
box is kept sixth from the top?

A.  F

B.  R

C.  D

D.  K

✓

Q94 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 7846513, what will be the sum of the digits
which are second from the left and third from the right in the new
number thus formed?

A.  12

B.  10

C.  14

D.  8

✓

Q95 Reasoning
WU 10 is related to ZS -3 in a certain way. In the same way, SP 17 is
related to VN 4. To which of the following is WY 29 related, following
the same logic?

A.  KM 9

B.  ZW 16

C.  JH 8

D.  JU 4

✓

Q96 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?
JFC LGF NHI PIL ?

A.  RJO

B.  MKL

C.  NJH

D.  GTY

✓

Q97 Reasoning
In a certain code language, 'SORRY' is coded as '40' and 'SURE' is
coded as '45'.
What is the code for 'GIFT' in the given code language?

A.  66

B.  61

C.  59

D.  54

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group? (Note: The odd man out is not based on
the number of consonants/vowels or their position in the letter
cluster)11626

A.  UPY

B.  SNV

C.  QLT

D.  OJR
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Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statements: All tables are goats. No table is a hen.

Conclusion (I): Some hens are goats.
Conclusion (II): All goats are hens.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

✓

Q100 Reasoning
Refer to the following letter series and answer the question.
Counting to be done from left to right only.
(Left) L M Q A Z W G B S E J N I O R U A T C F X K P (Right)
How many such vowels are there each of which is immediately
preceded by a consonant and also immediately followed by a
consonant?
6372

A.  2

B.  3

C.  1

D.  0
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